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  Logging Into WIN 
 

   
   

Open your internet browser* and enter: 
http://imercer.com/win in the address bar. Once the 
iMercer WIN window opens, complete the following 
steps: 
 
1. Click the Mercer WIN® link, located in the My 

Account section of the iMercer page.  
 
2. On the Mercer WIN Welcome page**, enter your 

email address in the Email field. 
 
3. Enter your password in the Password field.  The 

alphanumeric text will not display on the screen.  
Instead, an asterisk will represent each character. 

 

Note: If you can’t remember your password, click the 
Forgot Password? link and follow the instructions to receive a 
new password.. 
 
4. Once you have entered your data in the fields, click 

the Sign In button.  The WIN Home Page will 
display.*** 

 
*WIN currently supports Windows Internet Explorer 8+, Mozilla 
Firefox 3.6+, and Safari for Windows 5.0.  
 
**If you are already logged into iMercer.com, you will go 
directly to the WIN Homepage. 
 
***If you are signing in for the first time, a popup may prompt 
you to accept the licensing agreement for the market views 
your organization has purchased. 
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  The Mercer WIN Homepage 
 
 

 
 
 

1 Module Navigation – Click a button on this scrollable ribbon to access available WIN 
modules. 

2 Dashboard – Contains a number of mini-applications that are specific to your organization 
in a graphical, easy to understand format. 

3 Mercer News – Displays the latest Mercer articles and news items. 

4 

Header Links – The following links display in the WIN header and are accessible on every 
page in the Mercer WIN environment: 

 Upgrade Options – allows you to preview features available through Mercer WIN | Advanced 
and provides links to purchase an upgrade of your organization’s WIN account or to participate in 
a free trial of Mercer WIN | Advanced. 

 Help – accesses the WIN Online Help System. 

 Contact Mercer – initiates an email to Mercer. 
 About – provides information on licensing agreements and the current version of WIN. 
 My Profile – links to your User Profile page. 
 Sign Out – logs the user out of WIN.  
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  Dashboards 
 

A dashboard is a user interface that hosts a number of mini-applications known as widgets. The WIN Dashboard typically contains data 
that is specific to your organization in a graphical, easy to understand format, as well as links to pre-configured tasks. 
 
The following widgets are currently available on the WIN home page: 
 

Competitive Snapshot  
 
The Competitive Snapshot widget compares your 
organization's market data (mean annual base) with market 
data collected by Mercer from other organizations, by Job 
family. A drop-down list at the top of the widget allows you to 
select from market views that your organization has purchased 
and participated in. 
 
Each column on the grid represents a percentage range, and 
the colored cells alert you to how your organization’s Job 
family compares to the market median. (Ex. Green represents 
a ratio greater than -5% and less than 5%)  
 
 

My Market Views 
 
The My Market Views widget allows users quick and easy 
access to Mercer Market Views, including market view details 
and published reports. To go to a market view, click directly on 
the market view name listed in the Market View column. The 
link will redirect you to the Market View Detail page. 
 
 
 
 

I Want To… 
 
The I Want To... widget displays links to common tasks 
performed in the WIN system. Each task link will redirect you 
to another pre-configured page in the WIN system.   
 
View Mercer Market data by Job – takes you to the Search 
page with setting pre-configured to search by Job. 
 
View Mercer Market data by Position Class – takes you to 
the Search page with setting pre-configured to search by 
Position Class. 
 
Download a Mercer survey report – allows you to download 
published reports from market views. 
 
Edit My Profile – redirects you to the User Profile page.  
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  Searching Mercer Market Data 
  

 
1. On the WIN homepage, click the Mercer Market Data 

button. 
 

2. The Mercer Market Data Search page allows you to 
filter the market views that you conduct your job search 
on by year. The system automatically remembers the 
year setting for your last job search. To filter your 
market views by a different year, click the Change 
year link and select a year from the drop-down list. 

 

3. Above the Search Options section, one or more tabs 
will display depending on the market views you have 
purchased. Select the tab that represents the type of 
market view data you want to search. 

 Global – searches job and position class data that 
uses the Mercer Universal Position Coding System 
(MUPCS). 

 High Tech – searches regional job data that uses 
the APITT coding system. 

 All – searches local coded (non-MUPCS) job and 
position class data. The All tab will display when 
you have purchased at least one market view. 

Note: The Global and High Tech tabs will only appear if 
you have purchased market views with global and high tech 
data.. 
 

4. The Search Options section provides you with five 
search options:  
 

 Keyword – searches matching job titles and job 
codes. 

 Geography/Market View – select market views 
by region and country. 

 Family – searches job families and sub-families 
 Career Stream – searches career streams 

(Executive, Management, etc) and career 
levels. 

 Position Class – searches position classes 
within a specific range. 

 
Click a button and select the filter options for that 
metric. 

Note: The Position Class search option is only clickable when 
using a Position Class view. 
 

5. Click Apply. Your selections will display next to the 
button. 

Note: Each metric contains different filter options. For more 
information on individual metrics, refer to Configuring a Job Search in 
the WIN Online Help. 
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6. You can further modify your search by entering a 
keyword, such as job title, in the search field. 

 

7. Select the Limit to my jobs checkbox to filter the 
result set so that only jobs which include your 
organization’s participation data are returned. 

 

8. Select a view by clicking the  button next to the 
View: drop-down list and clicking on a view, or modify 
the current view by clicking the Edit button (see 
Adding a Custom View for details). 

 
9. Click Search. The results of the search will be 

displayed in grid format at the bottom of the page.  
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  Adding and Modifying Views 
 

The WIN system provides a set of pre-configured views that contain data grouped by logical categories. (Job, Position 
Class, Career Stream, etc). System views cannot be changed, but custom views can be created using the system views as 
templates. Custom views can be edited and also serve as templates for additional views.  
 
1. Click the View drop-down list and select the View 

you want to edit. 
 
2. Click the Edit button. 
 
3. Select the Mercer Market Data option. The middle 

pane will display all of the available data columns.  
 
4. Click the checkbox next to each column you want to 

add to your View. If you want to remove a column 
from your View, deselect the checkbox next to it.  

 

Note: Checkboxes for columns that are pre-configured for 
the selected template, as well as columns that cannot be used 
for the selected template will be grayed out. 
 
5. Once you have made all your selections, click the 

Save As button. 
 
6. A popup will prompt you to save your custom view. 

Enter a descriptive name for your view in the textbox 
and click Save. 

 
7. Click Done. 
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  Viewing Job Details 
 

 
1. After searching the Mercer Market Data, click directly on a 

job title to view the job details. The Job Detail page will 
display a job description and other information about the 
selected job. 

 
2. Click Close to close the Job Detail page and return to the 

Mercer Market Data page. 
. 
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  Comparing Jobs 
 
              

 
1. After searching the Mercer Market Data, click the 

checkbox next to each job you want to compare. 
You can compare up to 5 different jobs. 

 
2. Click Compare. 
 
3. The Compare Jobs page displays two jobs side-by-

side. To compare any other jobs you selected from 
the search list, click the  button at the top of 
either comparison window and select a job from the 
drop-down list. 

 
4. Click Close to close the Compare Jobs page and 

return to the Mercer Market Data page. 
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  The Mercer Market Data Results Page 
 
 

 
 
 

1 Display tabs – Click a tab to display market data in the listed format. 

2 My Saved Results – Click here to load a previously saved results set. 
3 Print and Export icons – Click these icons to create print-ready reports or export your data. 
4 Progress Center – Click here to access print and export jobs 
5 Modify Search – Click here to create a new results set.   
6 Add More Data – Click here to add additional data to your current results set. 
7 View – Click the drop-down list to select a view and the Edit button to create and modify views 
8 Refine Market – Click here to filter the market environment of your results set. 
9 Combine Jobs – Click here to combine two or more jobs. 

10 Combine PCs – Click here to combine a range of position classes. (Only available in PC views) 
11 Compare My Data – Click here to edit the Compare My Data feature. 
12 Normalize Data – Click here to normalize your data to a single currency and format. 
13 Age Data – Click here to define aging rates as well as "adjust-to" dates. 
14 Save – Click here to save the results set. 
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  Mercer Market Data Results Page Display Options 
 

WIN allows you to view data on the Results page in three types of format: Charts, Tables, and Details. To navigate between formats, click 
the labeled tabs. The default tab for the Results page is the Charts tab for first-time users; thereafter, the Results page will default to the 
last tab the user was on. 
 
 
Charts 
 
The Chart tab is divided into two panes. The left pane contains 
controls for chart type, market view, refinement type, etc. The 
right pane contains the chart itself, as well as controls for 
changing the Unit of Analysis (job, position class, etc) being 
displayed and controls for navigating between items in the 
result set. 
 
 
 

Table 
 
The Table tab displays market data in simple table (grid) 
format. Information displayed on the table is dependent on the 
selected view and market refinements. 
 
 
 
 
Details 
 
The Details tab displays information on the current job selected 
from the Unit of Analysis drop-down list. (Job or Position Class 
listing) This display option is divided into three sections: the left 
pane displays general job information, the right pane displays 
job descriptions, and the bottom pane displays market data 
information. 
 

Note: The Charts and Details tabs are not available in Bulk 
mode. 
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  Editing the Compare My Data Settings 
 

The Compare My Data popup allows you to set parameters for "Compare My Data" analysis. You can select your point of comparison to 
market and the type of results you wish to view (percent or amount to market) and save defaults. You can also select the type of data to 
display (organizational average or incumbent-level) and apply market refinement filters to your data. 
 
 
To edit the current Compare My Data settings, complete the 
following steps: 
 
1. On the Mercer Market Data Results page, click the 

Compare My Data button. 
 
2. On the Compare My Data popup, select or deselect your 

data comparison options using the checkbox next to each 
item. In the case of Statistic to Compare, use the drop-
down list to make your selection. 

 
3. Use the Display drop-down to select organizational 

average or incumbent-level data to compare. Selecting 
“Average” will set My Data to the system generated 
average of your organizational data. Selecting “Individual 
Employees” will set My Data to display incumbent-level 
data. 

 
4. Click the Apply button to apply your settings to the current 

analysis. 
 

Note: Use the On/Off toggle to enable/disable the 
Compare My Data feature. 

 

 For more information on Compare My Data settings, refer 
to Compare My Data section in the WIN Online Help. 
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  Combining Jobs 

 
 
 
 
 
1. After searching the Mercer Market Data, click 

the checkbox next to each job you want to 
review. 

 
2. Click Continue. 
 
3. On the Data Results page, click the Combine 

Jobs button. 
 
4. Select the market view you want to work with 

from the drop-down list.  
 
5. Click the checkboxes next to the jobs that you 

want to combine. 
 
6. Click Combine. 
 
7. A popup will prompt you to enter a job title and a 

code* for the combined job. Enter the 
information and click Apply to add this job to 
your system. 

 
8. The combined job will now appear in the job list, 

replacing the jobs used to create it. Repeat 
steps 4-7 for each combined job you want to 
create. 

 
9. Click Done to return to the Mercer Market Data 

Results page.  
 
 
*The Job Code should be a unique alphanumeric value. 
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  Combining PCs 
 
The Combine PCs option is available when a position class view (“Position Class,” “Position Class by 2”) or a view containing position 
class (“Family, Position Class,” “Job, Position Class”) has been selected. This option allows you to combine a range of position classes. 
 
 
1. On the Data Results page, click the Combine PCs 

button. 
 
2. Select the market view you want to work with from 

the drop-down list. By default, this option is set to 
combine PCs from “All” market views in the results 
set. 

 
3. If you select a single market view and the view is set 

to something other than “Position Class” (ex. 
“Family, Position Class”), a second drop-down will 
display. This option allows you to group the 
combined PCs according to the type of view 
selected (such as job, family, career stream, etc.) By 
default, this option is set to "All". 

 
4. Click the checkboxes next to the first position class 

and last position class in the range you want to 
combine. The checkboxes for the position classes 
between the upper and lower limits of the range 
automatically be selected. 

 
5. Click Combine. 
 
6. A popup will display the selected PC range. Click 

Apply to add this combined range to your system. 
 
7. The combined PC range will now appear in the 

position class list, replacing the position classes 
used to create it. Repeat steps 4-8 for each 
combined PC range you want to create. 

 
8. Click Done to return to the Mercer Market Data 

Results page.  
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  Refining and Saving a Results Set 
  

The WIN system allows you to narrow job market data so that you may, in essence, create a "snapshot" of the market 
environment. This allows you to more accurately price a job based on your unique market conditions. For more information on 
refining a results set, consult the Refine Markets section of WIN Online Help.  
 
1. After searching the Mercer Market Data, click the 

checkbox next to the job(s) you want to refine on the 
results grid. 

 
2. Click Continue. 
 
3. Click the Refine Market button. This option allows 

you to narrow the market environment so that it 
reflects the environment in which the job you want to 
benchmark exists. 

 
4. Select a category from the Market Refinements list. 
 
5. Select a market view and choose market refinement 

options from the middle column. Your refinements will 
display in the My Market Refinement Selections 
column. This column also allows you to combine 
refinements within the same market view, as well as 
providing you with the option of excluding your 
organization’s participation data from the market 
refinements.  

 
6. Click the Check for Data button. This tool allows you 

to validate whether the selected market refinements 
will yield results. An icon will appear next to each 
refinement which offers an indication of the amount of 
data the refinement will yield for the selected market 
view. 

 For more information on Check for Data, refer to the Check 
for Data section in the WIN Online Help. 
 
7. Click Done. 
 
8. The job will now list all the Market Refinements that 

you have selected. Click the Save or Save As buttons 
to save this job for future reference. 

 
9. The Save Results popup will prompt you to name the 

result set. Enter a unique name for your analysis in 
the text field and click the Save button. 

 

Your market snapshot will now appear in the My Saved 
Results drop-down list. 
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  Normalizing Data 
  

WIN's normalize data option allows you to set market data results to a single currency type and scaling format. For more 
information on the data normalization process, consult the Normalizing Data section of WIN Online Help.  
 
 
 
 
1. On the Data Results page, click the Normalize Data 

button. 
 
2. The Normalize Data popup will display. By default, 

scaling is set to "In Whole Numbers". To change 
scaling, click the On button next to Data Scaling: and 
select a scaling option from the drop-down list. 

 
3. To apply currency conversion, click the On button 

next to Convert Currencies to: and select a currency 
from the drop-down list. 

 
4. Click the Conversion Method drop-down list to 

display the available conversion years. Use the 
twisties ( / ) next to each year to display the Month 
Average options, and use to twisties next to the 
Month Average options to display a time period to 
select for the conversion method. 
 
Each available full year provides three conversion 
average options: 6 month average, 3 month average, 
and 1 month average. The selected average will be 
used to calculate the currency conversion rate. 
 

5. Click directly on a time period to select it as a 
conversion method. 
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6. Click the Calculate button. The exchange rates for 

the affected currencies will display in the table at the 
bottom of the popup. 

 
7. Click Apply to save the normalization settings and 

return to the Mercer Market Data Results page. 
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  Aging Data 
  

WIN's aging data option allows you to age market data based on the analysis you are trying to perform. This functionality allows 
you to define aging rates as well as "adjust-to" dates. Once data for a market view has been aged, WIN will apply the 
adjustment factor to all data from that market view in the data set. For more information on aging data, consult the Aging Data 
section of WIN Online Help.  
 

 
1. On the Data Results page, click the Age Data button. 
 
2. Click the On button next to Age Market Data. 
 
3. To also apply aging factors to your organization's 

data, click the On button next to Age My Data. 
 
4. Click directly in the Age to textbox or click the 

calendar icon  to access the calendar control. 
Using the control, you can select the month and year 
using the drop-down lists. Click directly on the 
calendar to select the date. 

 
5. Enter the aging percentages for the publication year 

and next year for each market view in the list. This 
data must be entered as a percentage. For all market 
views in the list that you don't want to age, enter "0". 

 
6. Click Calculate. The aging factors for each market 

view will display in the Aging Factor column. 
 
7. Click Apply to save the aging factors and return to 

the Mercer Market Data Results page. The data in 
your results set should now reflect your time 
adjustment settings. 
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  What Do I Do With My Results Set? 
 

WIN provides you with a number of options for retaining your results set for future use: 
 
 
Saving Your Results Set  

1. Click the Save As button at the bottom of the 
Mercer Market Data Results page. 

2. The Save Results popup will prompt you to name 
the result set. Enter a unique name for your analysis 
in the text field. 

3. Click the Save button. Your market analysis will now 
appear in the My Saved Results drop-down list. 

 
 
 
 
 
 
 
 
 
 
 
 
Exporting Your Results Set / Printing a Report  

1. Click the Export  or Print  icon, located at the 
top right-hand side of the Mercer Market Data Results 
page. 

 The Export option is only available in the Table tab. 

2. If you are creating a report, the Print Options popup 
will prompt you to select a report template. To 
preview a template type, simply click on the template 
name in the Report Templates pane, and an example 
of the selected report template will appear in the 
Sample panel. 

3. To select a report template, click on the template 
name in the Report Templates list and click the 
Continue button. 

4. A popup will prompt you to name the export or report 
and select the file type for your output. (such as 
Microsoft Excel (XLS) or Adobe PDF) 

5. Click Done. A popup will display informing you that 
the item has been sent to the Progress Center for 
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processing. 

6. Click the drop-down button next to the Progress 
Center icon at the top of the page. The Progress 
Center lists all of your recent reports and exports, as 
well as the dates they were submitted and their 
current statuses.  

7. Once the status displays "Complete", click directly on 
the name of your document to view results. 

8. A popup will prompt you to select whether to open the 
file or save it to your computer. Click the radio button 
next to your selection and click OK. 

9. When you return to the Mercer Market Data Results 
page, click the drop-down button to close the 
Progress Center. 
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